Curating data with OpenRefine to visualize them in
VOSviewer

If you choose to create a map based on bibliographic data to visualize keywords co-
occurrences in VOSviewer you will visualize keywords as they are indexed in the Web of
Science or Scopus. If written in a different manner, occurrences of the same term will be
considered as different items: e.g. “climate-change” and “climate change”, or “city” and
“cities”, while they are the same concept.

A small number of this kind of errors should not affect too much your visualization in
VOSviewer but too many of them could blur the picture and diminish the relevance of the
map. Most of these issues can be solved in few steps thanks to OpenRefine. This tutorial
explains how.

Curating data from Web of Science

Exporting data from the Web of Science

Export data from the WoS as you usually do when working with VOSviewer. As file format,
select the Tab-delimited format (Win, UTF-8).

Send to File

Number of Records: () All records on page

@ Records 1 to 500
Record Full Record and Cited References v
Content:
File Format Tab-delimited (Win, UTF-8) v
m Cancel

Creating a project in OpenRefine

Download OpenRefine on your computer and launch the software. Then upload the file you
want to clean in OpenRefine and click on Next.

R eﬁh e V5 A power tool for working with messy data.

Create Project Create a project by importing data. What kinds of data files can | import?

TSV, C8Y, *SV, Excel (.xIs and .xlsx), JSON, XML, RDF as XML, and Google Data

Open Project documents are all supported. Support for other formats can be added with

Import Project OpenRefine extensions.
Language Setlings Get data from Locate one or more files on your computer to
This Computer o
savedrecs(15).txt
Web Addresses (URLs)
- Next »
Clipboard
Google Data

Then you must make sure that the different fields of the file are well recognized. Select
the following options: CSV/TSV/separator-based files; separated by tabs (TSV); then
choose UTF-8 as the Encoding character and Parse next 1 line as column header and
create your project.
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DPEN

:
Ref,ne §pp A power tool for working with messy data

Create Project « Start Over = Configure Parsing Options Project name example_wos| Create Project »
Open Project PT AU BA BE GP AF BF CA T so E
=
1 J Ohanian, D Ohanian, Daniel Sympathy and GENOCIDE STUDIES
mport Project Exclusion: The INTERNATIONAL |
Language Settings Migration of Child
and Women

Survivors of the
Armenian Genocide
from the Eastern
Mediterranean to
Canada, 1923-1930

< | (1] 3

Parse data as Character encoding UTF-8 Update Preview
CSV/ TSV /separator-based  Columns are separated by [l ignore 0 line(s)
files * commas (CSV) first atbeginning of =
Line-based text files ® tabs (TSV) file
Fixed-width field text i ) Parse 1 lina(s)
‘ ixed-wi ield text files custom 1t next as column
PC-Axis text files Escape special characters with \ headers
\ =
JSON files "] Discard 0 row(s)

Vinrminm 40 FTOIILIA

Once your project is created, each row contains information about a publication and each
column is a metadata. The first line of the WoS file is the column header.

In the column “"DE”, go to “Edit cells”, “Split multi-valued cells”.

Reﬁh’e 5> example_Wos Permalink SocnSy oty fhic

Facet/ Filter  Undo / Redo 0 200 rows Extensio
Show as: rows records Sheodd Held »2Es
Using facets and filters § e [ |Tlot|(Z)sk[[T]Ho |[Y]DE v/iD
Facet »

Use facets and filters to select subsets

of your data to act on. Choose facet and
filter methods from the menus at the top Transform... Edit cells »
of each data column.

Text filter

Common transforms » | Edit column »
Not sure how to get started? ) Transpose »
Watch these screencasts Fill down
Blank down Sort...
View »

Split multi-valued cells...

Join multi-valued cells... Reconcile 4

Cluster and edit...

As separator, type : %; . Beware not forgetting the space after the semi-colon.

Split multi-valued cells
How to split multi-valued cells
@ by separator
Separator : regular expression
by field lengths

List of integers separated by commas, e.g., 5, 7, 15

OK  Cancel
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From now you have a difference between the number of rows (keywords) and the nmber
of records (publications).

ReﬁhNe 4> example_wos pem

Split multi-valued cells in column DE  Undo

Facet/Filter ~ Undo/Redo 1 1015 rows
Show as: rows records Show: 5 10 25 50 rows
Using facets and filters \/ e T/ A8 et
Canadian In 1918, some [Ohanian,
immigration 500,000 Univ Calif
Use facets and filters to select subsets Ottoman Angeles, t
of your data to act on. Choose facet and Armenians Los Angel
filter methods from the menus at the top found 90024 US
of each data column. nEAIselvES

displaced from
their homes or

Not sure how to get started? living in Muslim

Watch these screencasts households in
the Eastern
Mediterranean

and the South

Cauracie Far

Then, still in the column “DE”, go to “Edit cells” and “Cluster and edit”.

REﬁﬁNe L example_WOS Permalink

Facet/Filter ~ Undo / Redo 1 1015 rows
Show as: rows records Show: 5 10 25 50 rows
- . ) cL SP HoO DE D AB (]
Using facets and filters p | oS E hd hd d d
Facet > In 1918, some [Ohanian, C
Use facets and filters to select subsets Text filter g?&:g:‘ g:lg\;f;:m}—:-
of your data to act on. Choose facet and Armenians Los Ang;ele
filter methods from the menus at the top Edit cells > Transform... U
of each data column. X
Edit column > Common transforms »
Not sure how to get started? Transpose N
Fill down
Watch these screencasts
Sort... Blank down
View » Split multi-valued cells...
Reconcile > Join multi-valued cells...
Cluster and edit...

ars,war

A new window opens. You can select which terms you want to merge. First click on “Select
all”, then uncheck any words whose merging is irrelevant. By default, the new cell value is
the value that occurs the most often but you may desire to change it. Once you made your
choices, click on "Merge selected & re-cluster”.

This feature helps you find groups of different cell values that might be altemative representations of the same thing. For example, the two strings “New York” and “new
york” are very likely to refer to the same concept and just have capitalization differences, and "Gadel” and "Godel" probably refer to the same person. Find out more ...

Method key collision - Keying Function fingerprint - 16 clusters found

Cluster Size Row Count Values in Cluster Merge? New Cell Value “ #Choices in Cluster
3 5 + Familial Mediterranean Fever v Familial Mediterranean Feve ! i
« familial Mediterranean fever T

+ Familial Mediterranean fever

# Rows in Cluster

2 2 = Cardiovascular disease v Cardiovascular disease
« cardiovascular disease |
D ]
2 5 * Mediterranean Sea & Mediterranean Sea 1
* Mediterranean sea -
Average Length of Choices
2 3 = Biogeography v Biogeography | |
« biogeography L I
2 2 * Microsateliite v Microsateliite o
= microsateliite
2 4 « Nutrition 7 Nutrition
« nutrition
2 4 « Diet v Diet
a Aiat -
Select All  Unselect All Export Clusters | Merge Selected & Re-Cluster | Merge Selected & Close Close
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A second method of clustering is available: “nearest neighbor”, you may try it. Then close
this window.

"

Once this is done, in the column “DE”, go to “Edit cells”, “Join multi-valued cells”.

Reﬁhe §p» example_Wos Permalink
Facet/ Filter ~ Undo / Redo 3 1015 rows

Extract... Apply... Show as: rows records Show: 5 10 25 50 rows

Filter: ¥Y/CL Y SP Y HO ¥ DE v D ¥ AB vy
Facet » In 1918, some [Ohanian, Dal
0. Create project 500,000 Univ Calif Los
Text filter Ottoman Angeles, Hist
1. Mass edit 0 cells in column DE Ammenians Lo Angeles,
Edit cells > Transform... 15
2. Split multi-valued cells in column DE Edit column }  Common transforms »
3. Mass edit 55 cells in column DE Transpose Y Eill down
Sort. Blank down
View ¥ | Spiit multi-valued celis...
Reconcile b Join multi-valued cells...
Cluster and edit...

wars, war

Enter ;  as separator.

Enter separator to use between values

7 |

[ OK l | Annuler

You should now have as many rows as records. You can now save your project and export
the file in TSV (Tab-separated value).

Open... | Export~ He

Export project nsic
Tab-separated value ) las
Comma-separated value

5 HTML table FU
Excel (.xls)

Excel 2007+ (.xIsx)
ODF spreadsheet

Triple loader

MQLWrite

Custom tabular exporter...

Templating...

This file should be readable in VOSviewer as an original Web of Science file. The same
cleaning may be done with Scopus files, in a slightly different way.
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Curating data from Scopus

Exporting data from Scopus

Export data from Scopus as you usually do when working with VOSviewer in a comma-
separated value format (CSV).

Export document settings @ x
You have chosen to export 44530 documents

Select your method of export

AR MENDELEY ¥ Ref\orks RIS Format BibTeX Plain Text
EndNote, ASCil in HTML
Reference Manag]
What information do you want to export?
H Citation information [l Bibliographical informatig Abstract & keywords [l Funding details [ Other information
m Author(s) Affiliations Abstract Number Tradenames &
B Document title Serial identifiers (e.g. Author keywords Acronym manufacturers
B Year ISSN) Index keywords Sponsor Accession
& EID PubMed 1D Funding numbers &
8 Source title Publisher text chemieals
B volume, issue, Editor(s) .Cnnferen.cg
L information
pages Language of original B ndud
Citation count document neude
references

Source & Corraspondence
document type address
Dol Abbreviated source title

Cancl h

Creating a project in OpenRefine

Upload the file you want to clean in OpenRefine and click on Next. Choose UTF-8 as
character encoding and CSV separator-based file and create the project.

R eﬁﬁe - A power tool for working with messy data.
Create Project « Start Over Conf_lgure _ Project name scopus 45 csv Create Project »
Parsing Options
Open Project Authors Title Year Source title Volume Issue Art.No. Page start ‘\;l
Import Project 1. Eberhart New optimizer 1995 Proceedings 39 N
Language Settings Russell, using particle of the )
Kennedy swarm theory International
James Symposium
on Micro
Machine and
Human
Science
2. SwainM.J., Color indexing 1991 International 7 1 "
Ballard D.H Journal of ~
< i J »
Parse data as Character encoding UTF-8 Update Preview
CSVITSVI/ Columns are separated by [] Ignore 0 line(s)
separator-based © commas (CSV) first at beginning of =
files © tabs (TSV) fle
Line-based text © custom | Partse 1 | line(s)
nex as column
ﬁl.es . Escape special characters with \ headers
= Fixed-width field [*] Discard 0 row(s)
text files initial
Version 2.8 [TRUNK] initial - of data
PC-Axis text files [] Loadat O row(s)
Preferences JSON files most  of data
Haln naAmA E =~ w = A

In the column « Author keywords », « Edit cells », and click on « Split multi-valued
cells », write ™; ™ as separator. Then merge the terms in the same way than with the Web
of Science file.
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Reﬁ’ﬁ'é 4> scopus 45 csv Pemalink Qoenzy Wsporl

Facet/Filter ~ Undo/Redo 0 20 rows =

Show as: rows records Show: 5 10 25 B0t rowsvious 1-10 ne

- o »_“ ) ¥ | Author Ke: rd ¥ Document Ty ¥ | Access Type
Using facets and filters \/ L =2 £
ward Facet } inference Paper
Use facets and filters to select subsets S Text filter
of your data to act on. Choose facet and 4c8b2fd8275856b
filter methods from the menus at the top Edit cells b Transform...
of each data column. )
ward Edit column ¥ Common transforms »
Not sure how to get started? 52462108
Watch these sc?eencasb B7&partnerlD-40& Transpose > Fildown
0ab18f11c5c599%
o Sort... Blank down
2688781&
10870328 View ¥ spiit mutti-valued cells...
5f93e300f150d08  econcile ¥ Join multi-valued cells...
ward Cooperative control; Ar y
44309896& Graph theory; Cluster and edit...
AARRRRR Infrrmatinn

Finally join the multi-valued cells with “; ™ as separator and export the file as a csv file.
This file should be readable in VOSviewer.

Clean several files with the same rules

If you want to view several files in VOSviewer, the files curation in OpenRefine could take
some time, and the merging choices could not always be the same since the maximum
number of occurrences for a concept may change from one file to the other.

To be sure to apply always the same rules you can go in the "Undo/Redo” tab and click on
“Extract”.

R eﬁﬁfueﬁf savedrecs 34 txt pem:

Facet / Filter Undo/Redo 3

APPIY...

Filter:
0. Create project
1 Split multi-valued cells in column DE

2 Mass edit 55 cells in column DE

3. Join multi-valued cells in column DE

Then the different operations you have just made appear in JSON format. You may copy-
paste it as text.

Extract Operation History

Extract and save parts of your operation history as JSON that you can apply 1o this or other projects in the future

¥ Split multi-vaiued celis in column DE
% Mass edit cels in column DE
¥ Join multi-valued cels in column DE

Select Al Unselect All

Close
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Then, when you have created a new project for another file, in the “*Undo/Redo” tab, click
on “Apply”.

Ref,he 4 savedrecs 35 txt rer

Facet / Filter Undo / Redo 0

Infinite undo history /g
Don't worry about making mistakes.

Every change you make will be shown
here, and you can undo your changes
anytime.

Learn more »

Extract...

Paste the text with the history of operations you have done with the previous file and click
on “"Perform operations”.

Apply Operation History

Paste an extracted JSON history of operations to perform

To : -sustainable a gricuiture
1

{
"fromBlank": false,
"fromError": false,
"from™: [
"Epidemiology”,
"epidemiology”
Is
"to": "Epidemiology"

"fromBlank": false,
": false,

"Children",
"children”

Ir

"to": "Children"

"op": "cors/multivalued-cell-join",
"description”: "Join multi-valued cells in column DE",

Il

"separator

Perform Operations | Cancel

The file has been curated in the same way than the previous one. You may now export it
in the format you want to read it in VOSviewer.
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